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  Introduction
Introduction
These release notes describe requirements, restrictions, and caveats for Cisco Unified 
Personal Communicator. These release notes are updated for every maintenance release and every major 
release but not for patches or hot fixes.

Before you install Cisco Unified Personal Communicator, we recommend that you review this document 
for issues that might affect your system. For a list of the open caveats, see the “Open Caveats” section 
on page 24. 

System Requirements
• Network Requirements, page 2

• Server Requirements, page 8

• Client Computer Requirements, page 9

• Compatibility Matrix and Supported Upgrades, page 14

Network Requirements
For Cisco Unified Personal Communicator to successfully operate as an endpoint, your network must 
meet the requirements in these sections:

• Voice over IP, page 2

• Ethernet P rts and the Non-Autonegotiate Setting, page 2

• Network Ports Used by Cisco Unified Personal Communicator, page 3

• Routing Access Control Lists, page 6

• Quality of Service, page 7

• Network Address Translation, page 7

Voice over IP

You must configure voice over IP (VoIP) on your Cisco routers and gateways.

Ethernet P rts and the Non-Autonegotiate Setting

Make sure you configure all interfaces carrying media-type data (voice, video, web conferencing) 
between two endpoints to non-autonegotiate speed and duplex (for example, set all ports to 100 MB full 
duplex). You must also configure Ethernet interfaces on routers and switches in the cloud in this way.

If the autonegotiate setting is retained, negotiation can occur at any time, and if it occurs during a UDP 
transmission, that data is lost. Because voice data is UDP, users can experience significant voice quality 
problems. Similarly if any logical data is transmitted over UDP, serious system impairment might occur.
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Network Ports Used by Cisco Unified Personal Communicator

Cisco Unified Personal Communicator expects inbound and outbound traffic to occur on certain ports 
through certain protocols. 

Cisco Unified Personal Communicator lets the operating system pick a random port for the origination 
for every type of traffic except for these cases:

• For Session Initiation Protocol (SIP), SIP Instant Messaging and Presence Leveraging Extensions 
(SIMPLE), the OS uses a port in the range of 50000 to 50063. The client originates traffic from these 
ports and also connects to the Cisco Unified Communications Manager server and the Cisco Unified 
Presence server on these ports.

• For Real-Time Transport Protocol (RTP), Cisco Unified Personal Communicator selects its own 
port for sending and receiving. It uses port 16384 as the base port for the initial stream and uses 
higher port numbers for additional RTP and RTCP streams. For a given stream, the same port in the 
range is always used for transmission and reception.

For details, see the “Network Ports for Inbound Traffic” section on page 3 and the “Network Ports for 
Outbound Traffic” section on page 3.

Network Ports for Inbound Traffic

Table 1 lists the network ports for inbound traffic that Cisco Unified Personal Communicator monitors.

Network Ports for Outbound Traffic

Table 2 lists the network ports for outbound traffic to which Cisco Unified Personal Communicator 
connects. 

Table 1 Network Ports for Inbound Traffic

Protocol Ports Description

RTP 16384 to 16424 For audio and video.

SIP 50000 to 50063 Permits TCP or UDP traffic directed at the client computer.

If you configure Cisco Unified Personal Communicator to use TCP or 
UDP when making SIMPLE connections to Cisco Unified Presence, the 
server responds by using the same protocol. You configure these settings 
in Cisco Unified Presence Administration (choose Application > 
Unified Personal Communicator > Proxy Profile).

TFTP 16384 to 16424 --

Table 2 Network Ports for Outbound Traffic

Protocol Ports Description

HTTP 80 Connecting to Cisco Unified MeetingPlace Express or 
Cisco Unified MeetingPlace servers

IMAP1 (TCP or TLS) 143, 993, and 7993 Connecting with Cisco Unity Connection or 
Cisco Unity (with Microsoft Exchange) servers

RTP 16384 to 16424 For audio and video
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Configurations that Use Network Ports

You can use this network port information for these configurations:

• For integration with Cisco Security Agent for Unified Communications Manager or other 
applications that limit the types of activities that untrusted applications are allowed to perform on 
client computers.

• To unblock traffic destined to Cisco Unified Personal Communicator through a firewall. For details, 
see the “Configuring Network Ports on Client Computers” section on page 5.

To avoid blocking reachability status information, verify that firewalls on the client computer or on 
the network are configured to pass Cisco Unified Personal Communicator traffic. 

• To help prioritize Cisco Unified Personal Communicator traffic by applying quality of service 
(QoS) policies or routing access control lists (ACLs). For details, see the “Routing Access Control 
Lists” section on page 6 and the “Quality of Service” section on page 7.

SIP 5060 • Softphone registration to Cisco Unified 
Communications Manager 

• Presence information from Cisco Unified 
Presence using SIMPLE

TCP 389

2748

• Connecting to the LDAP2 server

• Connecting to the CTI gateway (which is the 
CTIManager component of Cisco Unified 
Communications Manager)

SOAP3 over HTTPS 443 • Configuration download from the Cisco Unified 
Presence server

• Connecting with Cisco Unified 
MeetingPlace Express servers

• Connecting with Cisco Unified MeetingPlace 
servers using HTTPS

TFTP 69

16384 to 16424

--

1. IMAP = Internet Mail Access Protocol

2. LDAP = Lightweight Directory Access Protocol

3. SOAP = Simple Object Access Protocol

Table 2 Network Ports for Outbound Traffic (continued)

Protocol Ports Description
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  System Requirements
Configuring Network Ports on Client Computers

Windows

When Cisco Unified Personal Communicator on Windows is run for the first time after installation, the 
firewall asks whether you want to block it or not, and the user must select Unblock.

Mac OS X 10.4.x

The ports used by the application must be manually configured on each system so that the application 
can function with the system firewall running. 

Procedure

Step 1 Choose the Apple menu > System Preferences to open a port range. 

Step 2 Click Sharing, and then click the Firewall tab. 

Step 3 Click New.

a. For Port Name, choose Other. 

b. For TCP Port Number, enter 50000-50063 to select this range. 

c. To allow UDP traffic, leave the UDP port number field blank.

If you have blocked UDP traffic and want to allow Cisco Unified Personal Communicator to use 
UDP, enter 50000-50063, 16384-16424.

d. For Description, enter a name; for example, Cisco Unified Personal Communicator. 

e. Click OK.

f. Click Advanced, and verify that Block UDP Traffic is unchecked, and click OK.

Mac OS X 10.5.x

Follow this procedure to passively or actively add Cisco Unified Personal Communicator to the allowed 
access list and permit communication through the firewall.

Procedure

Step 1 Choose the Apple menu > System Preferences > Security. 

Step 2 Click the Firewall tab on the Security window. 

Step 3 Select one of these choices:

• Allow All Incoming Connections 

In this situation, the firewall is essentially disabled.

• Set Access For Specific Services And Applications
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Step 4 If you select Set Access For Specific Services And Applications, add Cisco Unified 
Personal Communicator by one of these methods:

• Passively

The first time you run Cisco Unified Personal Communicator with the firewall in the Set Access For 
Specific Services And Applications state and incoming traffic tries to connect with Cisco Unified 
Personal Communicator, the system prompts you to allow or deny this connection. If you allow the 
connection, Cisco Unified Personal Communicator is automatically added to the list.

• Actively

Add Cisco Unified Personal Communicator by clicking +. Select Cisco Unified 
Personal Communicator, add it to the list, and make sure it says Allow Incoming Connections next 
to the listing.

These settings take effect immediately.

Troubleshooting Tips

If users experience problems with presence, preferred contact, phone mode switching, or instant 
messages, the firewall might be denying connections despite the previous allowed setting. Restart 
Cisco Unified Personal Communicator. If this does not resolve the issue, return to the Firewall settings, 
remove Cisco Unified Personal Communicator, and add it again to the list of applications that allow 
incoming connections.

Routing Access Control Lists

You must configure switching and routing ACLs so that Cisco Unified Personal Communicator can 
communicate with servers and endpoints that might be connected to the voice VLAN (the VLAN over 
which voice traffic is carried). 

By using ACLs, you can permit Cisco Unified Personal Communicator to connect to each server through 
the appropriate protocol through which the application communicates with that server. For example, you 
should allow UDP traffic in the port range that Cisco Unified Personal Communicator uses for RTP and 
and then label it with the appropriate QoS actions.

When Cisco Unified Personal Communicator is in soft-phone mode, this configuration enables 
Cisco Unified Personal Communicator to send RTP media to and to receive RTP messages from other 
audio and video endpoints across the IP network.

For details about ACLs, how to configure the voice VLAN, and how to configure QoS actions, see the 
switching and routing documentation for your network products.
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Quality of Service

Cisco Unified Personal Communicator uses Differentiated Services Code Point (DSCP) to mark Layer 3 
IP packets. Table 3 is an example of traffic guidelines for Cisco.

Note Microsoft Vista uses a new method for setting QoS parameters that is not compatible with Windows XP. 
Vista computers do not flag packets correctly with this version but instead set them to zero (0). 
(CSCsl50789). 

For a complete list of the guidelines, see this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/products_implementation_design_guide_cha
pter09186a008063744e.html#wp1043799

Typically, networks are configured to strip DSCP markings from computer traffic. Therefore, if you want 
Cisco Unified Personal Communicator traffic to be marked, you must configure switches and routers to 
apply DSCP markings to computer traffic based on the port ranges that the application uses. You also 
must configure destination addresses with which Cisco Unified Personal Communicator communicates.

For details about QoS and DSCP markings, see the switching and routing documentation for your 
network products.

Network Address Translation

The Cisco Unified Personal Communicator is not compatible with Network Address Translation (NAT). 
It does not support Simple Traversal of UDP through Network Address Translation (STUN), Traversal 
using NAT (TURN), or any other NAT-traversal scheme. 

To traverse NAT, Cisco Unified Personal Communicator must be behind a virtual private network (VPN) 
connection.

Table 3 Traffic Classification Guidelines for Network Traffic

Application

Layer 3 Classification Layer 2 Classification

IP Precedence Per-Hop Behavior DSCP Class of Service

Voice RTP 5 EF 46 5

Video 
conferencing

4 AF41 34 4

Call signaling 3 CS3 24 3
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Server Requirements
• Required Servers, page 8

• Recommended Servers, page 8

• Unsupported Server Configurations, page 9

Required Servers

These servers are required for Cisco Unified Personal Communicator operation:

• Cisco Unified Communications Manager is installed in your network and is configured to handle 
call processing. It provides Cisco Unified IP Phone control through the Cisco Unified 
Communications Manager computer telephony interface (CTI). For Cisco Unified 
Communications Manager details, see this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

• Cisco Unified Presence is installed and is operational. It provides the Cisco Unified 
Personal Communicator client configuration and presence information. For Cisco Unified Presence 
details, see this URL:

http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

• LDAP server version 3

For supported software versions, see the “Compatibility Matrix and Supported Upgrades” section on 
page 14.

Recommended Servers

For full functionality of Cisco Unified Personal Communicator, you need these products installed and 
operational:

• Voice-mail servers (for voice-mail retrieval and play back):

– Cisco Unity Connection (for mid-market customers with up to 1500 users)

http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

– Cisco Unity (for enterprise and mid-market customers with Microsoft Exchange environments)

http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products_support_series_home
.html

• Conference servers (for video and web collaboration):

Video Conferencing:

– Cisco Unified MeetingPlace enables users who are in Cisco Unified Personal Communicator 
conversations to initiate impromptu (ad hoc) voice, video, and web conferences through 
Cisco Unified Personal Communicator. Cisco Unified MeetingPlace provides a richer web 
conferencing experience than with Cisco Unified MeetingPlace Express VT.

For Cisco Unified MeetingPlace details, see this URL:

http://www.cisco.com/en/US/products/sw/ps5664/ps5669/tsd_products_support_series_home.
html
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  System Requirements
– Cisco Unified MeetingPlace Express VT enables users who are in Cisco Unified 
Personal Communicator conversations to initiate impromptu (ad hoc) voice, video, and web 
conferences through Cisco Unified Personal Communicator.

For details about integrating Cisco Unified MeetingPlace Express VT and Cisco Unified 
Personal Communicator, see this URL:

http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

– Cisco Unified Video conferencing provides audio and video support for merged conference 
calls (three or more parties) placed through Cisco Unified Personal Communicator. For details 
about the MCUs, see this URL:

http://www.cisco.com/en/US/products/hw/video/ps1870/tsd_products_support_series_home.ht
ml

Web Collaboration:

– Cisco Unified MeetingPlace Express enables users who are in Cisco Unified 
Personal Communicator conversations to quickly share desktop screens and documents through 
a private, reservationless, web-only voice meeting.

Some Cisco Unified MeetingPlace Express features are not available or are not supported with 
meetings initiated through Cisco Unified Personal Communicator. For details, see the 
Cisco Unified Personal Communicator user guide at this URL:

http://www.cisco.com/en/US/products/ps6844/products_user_guide_list.html

For details about integrating Cisco Unified MeetingPlace Express and Cisco Unified 
Personal Communicator, see this URL:

http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

For supported software versions, see the “Compatibility Matrix and Supported Upgrades” section on 
page 14.

Unsupported Server Configurations

These servers are not supported for use with Cisco Unified Personal Communicator:

• Cisco Unified Survivable Remote Site Telephony (SRST)

• Cisco Unity Express

• Cisco Unified Communications Manager Express

Client Computer Requirements
Before you install Cisco Unified Personal Communicator on any computer, the computer should meet 
the requirements described in these sections:

• Platform Requirements, page 10

• Supported Phones, page 13

• Supported Audio and Video Codecs, page 14

• Software Interoperability, page 14
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Platform Requirements

Table 4 and Table 5 list the platform requirements for Cisco Unified Personal Communicator.

Table 4 Windows Platform Requirements for Cisco Unified Personal Communicator  

Item Description

Internal Hardware Microsoft Windows XP:

• 1.8 GHz or faster Pentium 4 or compatible processor (2.4 GHz or faster recommended for 
video calling capabilities) 

Note Only 32-bit (x86) processors are supported.

• Memory: 512 MB RAM (1 GB RAM recommended for video calling capabilities)

• Video requirements: DirectX 9.0c-compatible graphics card with at least 64 MB free video 
RAM (128 MB for dual-headed configurations)

• Disk space: 200 MB free disk space for (includes 20 MB free disk space for the Windows 
camera drivers)

• A non-ISA full-duplex sound card (integrated or PCI-based) or USB sound device

• A 10/100 Mbps Ethernet network interface card

Microsoft Windows Vista:

• Microsoft Vista Premium Ready PC. For details about the minimum hardware requirements 
for Windows Vista (in addition to the requirements in this table), search for Premium Ready 
PC on the Microsoft website or see this URL: http://support.microsoft.com/kb/919183

– Only 32-bit (x86) processors are supported.

– Hardware in computers running Vista and Cisco Unified Personal Communicator using 
video must have a base score of 3 or higher. Run the performance tool by choosing Start 
> Control Panel, and clicking Performance and Rating. 1

The subscores for Memory (RAM), Graphics, and Gaming Graphics must be 3 or higher.

The Overall Base Score must be 3 or higher.

• Disk space: 200 MB free disk space for (includes 20 MB free disk space for the Windows 
camera drivers)

• A non-ISA full-duplex sound card (integrated or PCI-based) or USB sound device

• A 10/100 Mbps Ethernet network interface card
10
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Software • Microsoft Windows XP Professional (Service Pack 2)

• Microsoft Windows Vista Business Edition or Enterprise Edition

• (For Windows XP) Macromedia Flash Player 6.0.79 or higher required for web conferencing

(For Windows Vista) Adobe Flash Player ActiveX or Adobe Flash Player 9 (version 9.0.28 
or higher)

Obtain the list of supported browsers in the Release Notes for Cisco Unified 
MeetingPlace Express at this URL:

http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

• Microsoft DirectX 9.0c

• Microsoft Outlook 2003 or 2007 required for click-to-dial toolbar support

• USB audio device hotfixes2 (for Windows XP): KB 914642 and KB 884868

• Cisco VPN Client software, Release 4.0.5 or later

USB Headsets Tested by Cisco in audio soft-phone mode and for voice-mail playback:

• Plantronics: DSP-400, DSP-510, DSP-550

• Sony DA260 USB

• Logitech USB 250

For details about USB headsets, see the installation guide at this URL:

http://www.cisco.com/en/US/products/ps6844/prod_installation_guides_list.html

Video Cameras3 Required for video calls.

Cameras tested by Cisco:

• Cisco VT Camera

• Cisco VT Camera II (see the “Important Notes” section on page 22)

• Logitech QuickCam Fusion

• Logitech QuickCam for Notebooks Pro

• Microsoft LifeCam VX-6000 (68C-00001) 

• Creative Web Cam Live! Pro USB 2.0 Web Cam

Connectivity High-speed connection required for softphone calls (128 kbps for audio calls and 300 kbps for 
calls with video)

1. If users experience memory leaks while using video and the amount of memory dedicated to video is zero or very small, disable Vista visual effects by 
going to Control Panel > Classic View > Performance Information and Tools > Adjust visual effects > Adjust for best performance.

2. To obtain the hotfixes, go to the Microsoft Support URL: http://support.microsoft.com/contactus/?ws=support or call Microsoft (1-800-MICROSOFT 
(1-800-642-7676)

3. Not all cameras are available for all supported operating systems. See your camera documentation for the supported operating systems.

Table 4 Windows Platform Requirements for Cisco Unified Personal Communicator (continued) 

Item Description
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Note Using video with Cisco Unified Personal Communicator over a corporate wireless LAN may result in 
poor audio and video quality and is not supported. Video calls can be placed or received on a remote 
wireless LAN connection with a minimum broadband link of 300kbps/300kbps. For best results, we 
recommend that you use video over a wired Ethernet connection whenever possible.

Table 5 Apple Macintosh Platform Requirements for Cisco Unified Personal Communicator

Item Description

Internal Hardware • 1.4 GHz or faster PowerPC G4 or compatible processor (any Macintosh with PowerPC G5 
or Intel processor recommended for video calling capabilities)

– A non-ISA full-duplex sound card (integrated or PCI-based) or USB sound device

– A 10/100 Mbps Ethernet network interface card

• Disk space: 200 MB free hard disk space

• Memory: 512 MB RAM (1 GB RAM recommended for video calling capabilities)

USB Headsets Tested by Cisco in audio soft-phone mode and for voice-mail playback:

• Plantronics: DSP-400, DSP-510, DSP-550

• Sony DA260 USB

• Logitech USB 250

For details about USB headsets, see the installation guide at this URL:

http://www.cisco.com/en/US/products/ps6844/prod_installation_guides_list.html

Video Cameras Required for video calls:

• Apple iSight camera required for video calls (Firewire 400 port required when using an 
external iSight camera)

Software • Mac OS X 10.4.7 (Tiger)

• Mac OS X 10.5.1 (Leopard)

• Macromedia Flash Player 6.0.79 or higher required for web conferencing

Obtain the list of supported browsers in the Release Notes for Cisco Unified 
MeetingPlace Express at this URL:

http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

• Apple Address Book 4.0.4 (485.1) or later (available in Mac OS X) for local address book 
support

• Cisco VPN Client software, Release 4.0.5 or later

Connectivity High-speed connection required for softphone calls (128 kbps for audio calls and 300 kbps for 
calls with video)
12
Release Notes for Cisco Unified Personal Communicator, Release 1.2

OL-11718-02

http://www.cisco.com/en/US/products/ps6844/prod_installation_guides_list.html
http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html


 

  System Requirements
Note The headsets were tested for audio sending and receiving only. Cisco Unified Personal Communicator 
does not support function buttons that might be available with a specific headset.

While Cisco does perform basic testing of third-party headsets and handsets for use with Cisco Unified 
Personal Communicator, it is ultimately the responsibility of the customer to test this equipment in their 
own environment to determine suitable performance. Due to the many inherent environmental and 
hardware inconsistencies in the locations where Cisco Unified Personal Communicator is deployed, 
there is not a single best solution that is optimal for all environments.

A list of vendors that have verified their devices for use with Cisco Unified Personal Communicator 
through the Cisco Technology Developer Program is available at 
http://www.cisco.com/pcgi-bin/ecoa/Search?&KeywordSearch=1&isAffil=. From the Solutions 
drop-down list, select IP Communications > Voice Endpoints–Soft Phones.

These devices passed lab testing and met interoperability criteria, ensuring that Cisco product 
specifications are reached.

Supported Phones

Table 6 lists the phones tested with Cisco Unified Personal Communicator. These phones are enabled 
for Cisco Computer Telephony Interface (CTI) mode in Cisco Unified Communications Manager.

Some older phones that support CTI when configured as a SCCP phone cannot support CTI as a SIP 
phone:

• Any older model of Cisco Unified IP Phone (for example, a 7940 or a 7960 that has less memory 
than the newer Cisco Unified IP Phones and is not Java based) does not support CTI if configured 
as a SIP phone 

• Any new Java-based Cisco Unified IP Phone (for example, 7940G, 7960G, or 7970 models with 
more memory than older Cisco Unified IP Phones) do support CTI if configured as a SIP phone.

Table 6 Phones Tested with Cisco Unified Personal Communicator

Phone SCCP1

1. SCCP = Skinny Call Control Protocol

SIP2

2. SIP = Session Initiation Protocol

Cisco Unified IP Phone 7911G Yes Yes

Cisco Unified IP Phone 7912G Yes No

Cisco Unified IP Phone 7941G-GE Yes Yes

Cisco Unified IP Phone 7960G Yes No

Cisco Unified IP Phone 7961G-GE Yes Yes

Cisco Unified IP Phone 7970G Yes Yes

Cisco Unified IP Phone 7971G-GE Yes Yes

Cisco Unified IP Video Phone 7985G Yes No
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These phones are not supported for use with Cisco Unified Personal Communicator:

• Cisco Unified IP Conference Stations 7935 and 7936

• Analog Telephone Adapter (ATA) 186 and 188

• Cisco IP Communicator

• Models not enabled for CTI

• Any untested model

Supported Audio and Video Codecs

A codec is an implementation of an algorithm capable of performing encoding and decoding on a digital 
data stream. Codecs are used to encode and decode data (such as sound and video streams) that would 
otherwise use large amounts of network bandwidth when transmitted or disk space when stored.

Cisco Unified Personal Communicator supports these codecs:

• Audio codecs: G.711a, G.711u, G.729a, Internet Low Bit Rate Codec (iLBC)

• Video codecs: H.263, H.264 

– Common Intermediate format (CIF): 352x288 up to 30 frames per second (depends on client 
computer capabilities)

– Quarter CIF (QCIF): 176x144 at 30 frames per second (depends on client computer capabilities)

– Quarter VGA (QVGA): 320x240 at 30 frames per second (depends on client computer 
capabilities)

– Quarter Quarter VGA(QQVGA): 160x120at 30 frames per second (depends on client computer 
capabilities)

Software Interoperability

Cisco Unified Personal Communicator, Cisco Unified Video Advantage, and Cisco IP Communicator 
can co-exist on the same client computer. However, we recommend that you do not simultaneously run 
these products.

Cisco Unified Personal Communicator users can make calls to Cisco Unified Video Advantage 
endpoints as long as they are in the same Cisco Unified Communications Manager cluster. However, 
Cisco Unified Personal Communicator users cannot use Cisco Unified Video Advantage to call another 
user. 

Compatibility Matrix and Supported Upgrades
Table 7 lists the supported release combinations of Cisco Unified Personal Communicator and other 
servers.
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For compatibility and upgrade information for Release 1.1, see the release notes for that release:

http://www.cisco.com/en/US/products/ps6844/prod_release_notes_list.html

For details about performing upgrades, see the Cisco Unified Personal Communicator installation guide 
at this URL:

http://www.cisco.com/en/US/products/ps6844/prod_installation_guides_list.html

Table 7 Supported Release Combinations

CUPC1

1. CUPC = Cisco Unified Personal Communicator

CUCM2 and CUP3

2. CUCM = Cisco Unified Communications Manager

3. CUPS = Cisco Unified Presence

LDAP
Voice-Messaging 
Servers

Web Collaboration and Video 
Conferencing Servers

1.2(4)

1.2(3)

1.2(2)

5.1(2) and 6.0(2)

6.0(1) and 6.0(2)

6.1(1) and 6.0(2)

• Microsoft Active 
Directory (AD 2003) 

• Sun One Directory 
Server 5.2 

Cisco Unity 
Connection:

• 2.0 (standalone 
and co-resident 
with CUCM)

• 1.2

Cisco Unity:

• 4.2 (Exchange 
2003)

• 5.0 (Exchange 
2003 and 2007)

Web collaboration:

• MeetingPlace Express:1.2

• MeetingPlace Express VT:1.2, 
2.0

• MeetingPlace: 6.0

Video conferencing:

• CUVC4:Release 5.x software 
with 3515 MCU or 3545 
System

• MeetingPlace: 5.4 (requires 
CUVC 5.x), 6.0

• MeetingPlace Express VT: 1.2, 
2.0

4. CUVC = Cisco Unified Videoconferencing

1.2(1) 5.1(1) and 6.0(1)

5.1(2) and 6.0(1)

6.0(1) and 6.0(1)

• Microsoft Active 
Directory (AD 2003) 

• Sun One Directory 
Server 5.2 

Cisco Unity 
Connection:

• 2.0 (standalone 
and co-resident 
with CUCM)

• 1.2

Cisco Unity:

• 4.2 (Exchange 
2003)

• 5.0 (Exchange 
2003 and 2007)

Web collaboration:

• MeetingPlace Express:1.2

• MeetingPlace Express VT:1.2, 
2.0

• MeetingPlace: 6.0

Video conferencing:

• CUVC: Release 5.x software 
with 3515 MCU or 3545 
System

• MeetingPlace: 5.4 (requires 
CUVC 5.x), 6.0

• MeetingPlace Express VT: 1.2, 
2.0
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  Related Documentation
Related Documentation
For complete documentation for Cisco Unified Personal Communicator, see the documentation guide at 
this URL:

http://www.cisco.com/en/US/products/ps6844/products_documentation_roadmaps_list.html

You can find related product information at these URLs:

• Cisco Unified Communications Manager documentation:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

• Cisco Unified Presence documentation:

http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

• Cisco Unity Connection documentation:

http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

• Cisco Unity documentation:

http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products_support_series_home.htm
l

• Cisco Unified MeetingPlace Express documentation:

http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

• Cisco Unified MeetingPlace documentation:

http://www.cisco.com/en/US/products/sw/ps5664/ps5669/tsd_products_support_series_home.html

New and Changed Information 
• Release 1.2(4), page 16

• Release 1.2(3), page 16

• Release 1.2(2), page 17

• Release 1.2(1), page 19

Release 1.2(4)
Cisco Unified Personal Communicator Release 1.2(4) is a maintenance release for fixing defects. For 
details, see the “Resolved Caveats” section on page 28.

Release 1.2(3)
Cisco Unified Personal Communicator Release 1.2(3) is a maintenance release for fixing defects. For 
details, see the “Resolved Caveats” section on page 28.
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  New and Changed Information
Release 1.2(2)
Cisco Unified Personal Communicator Release 1.2(2) is a localization release and maintenance release.

For localization, these languages are supported on Windows and Mac OS X:

• Chinese (traditional and simplified) (CHT and CHS)

• Danish (DAN)

• Dutch (NLD)

• French (FRA)

• English (EN)

• German (DEU)

• Italian (ITA)

• Japanese (JPN)

• Korean (KOR)

• Portuguese (Brazilian) (PTB)

• Russian (RUS)

• Spanish (ESP)

• Swedish (SVE)

Note Arabic is not supported.

The maintenance release offers bug fixes. For details, see the “Resolved Caveats” section on page 28. 
The maintenance release also offers user interface enhancements.

Windows OS:

• Modal versus modeless windows—the user is now restricted from opening certain windows when 
other windows are open. Windows with the modal behavior are:

– Preferences

– Edit Status

– Choose Phone to Control 

– Create/Rename Group

– Edit Nickname

– Format Columns

– About Cisco Unified Personal Communicator

Secondary windows are now modal: Edit Status > Add/Edit Annotation and Choose Phone to 
Control > Rename Device.

Windows with modeless behavior are the IM, Session, Call History, Voicemail, Dialer, Invite 
Participants, and the Contact Card windows.

• Start Cisco Unified Personal Communicator when Windows starts (Preferences > Profile).

• Change the width of a column by applying the best-fit option or by manually entering a column 
width. 

• Sort items in a lists in ascending order (A to Z).
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  New and Changed Information
• Add contacts to the contact list by dragging and dropping from the search results list, the recent 
communications list, or from the roster.

• Re-organize contacts by dragging and dropping from one group to another or by copying the contact.

• Use matching navigation to search for names in the Recent or the Search list.

• Resize the session window during a video call, and resize the video.

• Display the local video in a picture-in-picture (PIP) format. Ability to move and resize the PIP 
window within the video area.

• Configure Cisco Unified Presence and Cisco Unified Personal Communicator to retrieve contact 
pictures from a web server (instead of from the LDAP server).

• Accessibility features: 

– Ability to use Cisco Unified Personal Communicator through the keyboard instead of a mouse.

– Tab to any control (across the console, through collapsible sections, and so forth)

– Navigate to any window

– Keyboard shortcuts

– Operate the context menu from the keyboard

Mac OS X:

• Support for Mac OS X 10.5.x (Leopard)

• Add contacts to the contact list by dragging and dropping from the search results list, recent 
communications list, and from the roster.

• Re-organize contacts by dragging and dropping from one group to another or by copying the contact.

• Sort items in a list in ascending (A to Z) and descending (Z to A) order by first name.

• Drag and drop contacts (in the contact list, search results, recent communication, search results) 
from Cisco Unified Personal Communicator to other applications on Mac OS X. For example, 
contacts can be added to the Address Book.app, or into the recipient list in Mail.app, or onto the 
Finder (to create a VCard file) with drag and drop.

• Set or change availability status from a File > Status menu option instead of using a pop-up menu.

• Resize the session window during a video call, and resize the video when the remote video window 
is displayed.

• Improved universal access and accessibility: improved keyboard navigation and control, improved 
keyboard focus indication, and improved voice-over support and integration.

• Support for scripting using AppleScript.

• Adjust device volume through the Audio/Video Preferences window instead of using the System 
Preferences application. Set the output for all alerts and the incoming call ringer from the Ringer & 
Alerts device selection. The Audio Call Output device selection is only for Audio Call output.

• Ability to quickly find contacts in the contact list, recent communications list, or in the search results 
with type-ahead selection.

• Anchor the local video picture-in-picture in the center of the video display in addition to the four 
corners of the video display area (for example, for when in a video conference call that shows the 
conference participants in each quadrant of the video).

• Configure Cisco Unified Presence and Cisco Unified Personal Communicator to retrieve contact 
pictures from a web server (instead of from the LDAP server).

For details, see the “Documentation Updates” section on page 34.
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  New and Changed Information
Release 1.2(1)
Cisco Unified Personal Communicator Release 1.2(1) supports these features:

• Integration with Cisco Unity through an Internet Mail Access Protocol (IMAP) connection with the 
voice-mail repository on the Exchange server

– Ability to download, play, sort, delete, and purge voicemail (no additional licensing costs are 
incurred)

– Support for G.729-encoded playback in Cisco Unified Personal Communicator of voice-mail 
messages received from Cisco Unity servers

– Encrypt user credentials to the voice-mail server and encrypt downloaded voice-mail messages

– Support for both the Cisco Unity unified messaging and the Cisco Unity voice messaging 
configurations. With unified messaging, the Exchange server e-mail account supports both 
voicemail and e-mail. With voice messaging, the Exchange server e-mail account contains only 
voice-mail messages.

– Message waiting notification—Cisco Unified Personal Communicator notifies the user when 
new messages arrive

• Integration with Cisco Unified MeetingPlace through HTTP and HTTPS requests

– Cisco Unified Personal Communicator automatically detects the server type (whether it is 
connected to Cisco Unified MeetingPlace, Cisco Unified MeetingPlace Express, or to 
Cisco Unified MeetingPlace Express VT) 

– Configuration of Cisco Unified MeetingPlace in Cisco Unified Presence Administration is the 
same as it is for Cisco Unified MeetingPlace Express

– Cisco Unified Personal Communicator users specify only one set of credentials in the Account 
Preferences window for the Cisco Unified MeetingPlace profile to which they are assigned

– Ad-hoc Cisco Unified Personal Communicator meetings are hidden from 
Cisco Unified MeetingPlace meetings (just as they are with Cisco Unified 
MeetingPlace Express)

– Cisco Unified Personal Communicator users have the ability to escalate to a web collaboration 
session from within Cisco Unified Personal Communicator session

• Failover from a primary to a back-up server:

– Cisco Unified Communications Manager (for soft-phone mode)

– CTI gateway (for desk-phone mode)

– LDAP server

• Person-to-person instant messaging (IM)—ability to communicate by using IM with a Cisco Unified 
Personal Communicator user or with a Cisco Unified IP Phone Messenger (IPPM) user registered 
to the same Cisco Unified Presence server:

– Automatic response IM messages include the customized reachability information of the remote 
user 

– Clickable web URLs in the message body that open a browser or e-mail client

– Clickable mail to and e-mail address patterns in the message body that open a browser or e-mail 
client

– Clickable North American (US, Canada, Mexico) phone number patterns in the message body 
that open a new conversation window
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  New and Changed Information
– Timestamp incoming and outgoing IM messages

– Color code incoming and outgoing IM messages for each participant

– Escalate to an audio, or an audio and a video, conversation from within the IM conversation 
window

– Initiate an e-mail from within the IM conversation window

– Specify the font size, family, and color for sending and receiving IM messages

– Support for text selection in the IM conversation window, copy in previous conversation 
window and pending-text pane, cut and paste in the pending-text pane, remote user is typing 
indicator, and remote user name and reachability state

– Ability to save an IM conversation to a file

• Improve reachability

– Persistent away—users can select Out of Office and an associated message when they are 
logged off of Cisco Unified Personal Communicator (for example, “On vacation; back in two 
weeks”)

– Show own presence—visual indicator of the current reachability state for the user

– Ignore phone busy—users can choose to not appear busy when they are on the phone

– Busy from Outlook Exchange—users can use their Outlook free and busy status as a component 
of their reachability status in Cisco Unified Personal Communicator

– Presence for line appearance—reachability based on line appearances rather than being limited 
to presence for a whole line

• Improve usability

– Counter in Recent Communications pane to show the number of new or unread voicemails the 
user has in their Cisco Unity or their Cisco Unity Connection mail box

– Visual indicator on Cisco Unified Personal Communicator that simultaneously lights when the 
message waiting indicator lights on the physical phone

• Improve accessibility

– Each menu item has a mnemonic (Windows only) or access key (for example Q for Quit)

– Menu items have the letter of the mnemonic keystroke underlined (Windows only)

– All toolbar actions have menus

• Improve serviceability

– Call statistics enhancements—provide additional triggers for call statistics collection

– System health enhancements—provide information about the health of connections to back-end 
servers

– Input device status—Cisco Unified Personal Communicator recognizes whether an input device 
(such as an external or built-in microphone, USB headset, video camera, and so forth) is 
properly registered and displays information in the Input Device Status window. If a device 
become unavailable, Cisco Unified Personal Communicator prompts the user to re-enter their 
device choices

– Detailed trace settings—allow users to enable detailed debug tracing to aid in troubleshooting
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  Installation Notes
• Outlook integration

– From within the Outlook Address Book application, dial phone numbers (click-to-dial) through 
Cisco Unified Personal Communicator by means of the Outlook toolbar

– Cisco Unified Presence makes available the free and busy information from the Exchange 
server to Cisco Unified Personal Communicator for use when computing the reachability status 
of a user 

• Contact list—Add a contact found in the LDAP directory as a contact in Cisco Unified 
Personal Communicator

• TFTP download of the Cisco Unified Communications Manager configuration files needed for 
Cisco Unified Personal Communicator soft-phone operation

• Support for adjunct licensing in Cisco Unified Communications Manager Release 6.0—Associates 
a secondary soft-phone device with a primary device and consumes only one device license per 
device.

• Support for Microsoft Windows Vista—Cisco Unified Personal Communicator now runs on this 
operating system.

For information about all available features and benefits, see the Cisco Unified Personal Communicator 
datasheet at http://cisco.com/en/US/products/ps6844/products_data_sheets_list.html.

Installation Notes
You must order the Cisco Unified Personal Communicator system software and licenses by contacting 
your Cisco sales representative or by going to http://www.cisco.com/en/US/ordering/index.shtml. 

After placing the order, you will receive information on where to find documentation for Cisco Unified 
Personal Communicator along with the Product Authorization Key (PAK). The PAK provides the 
software activation key and the license file. For details about obtaining the license file, see the 
Cisco Unified Personal Communicator installation guide at this URL:

http://www.cisco.com/en/US/products/ps6844/prod_installation_guides_list.html

You download Cisco Unified Personal Communicator software from the Software Center 
(http://www.cisco.com/public/sw-center/sw-voice.shtml). You must have an account on Cisco.com to 
access this site. 

For step-by-step installation instructions, see the Installation Guide for Cisco Unified 
Personal Communicator.

Limitations and Restrictions
You should review Table 8 before you begin working with Cisco Unified Personal Communicator. These 
are known limitations that will not be fixed, and there is not always a workaround. Some features might 
not work as documented, and some features could be affected by recent changes to the product. Make 
sure to read the “Important Notes” section on page 22.

For information about open and resolved caveats, see Table 9 on page 25 and Table 13 on page 31.
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  Important Notes
Important Notes
• IMPORTANT NOTICE - PLEASE READ: During an emergency, softphone technology may not 

provide the most timely or accurate location data if used for a 911 emergency call. Calls may be 
misdirected to the wrong emergency response center or the emergency response center may make 
errors when determining your location. USE A SOFTPHONE ONLY AT YOUR OWN RISK 
DURING AN EMERGENCY. Cisco will not be liable for resulting errors or delays. 

• The Cisco VT Camera II operates most effectively with USB version 2.0. While the Cisco VT 
Camera II will operate with USB version 1.1, we do not recommend this configuration.

Cisco Unified Personal Communicator might hang if the Cisco VT Camera and headset are plugged 
into a hub that does not have an external power adapter. We recommend that you plug the camera 
and headset directly into the USB ports on the computer. If there are not enough USB ports on the 
computer, you can use a hub that is equipped with a external power adapter to provide enough power 
for multiple USB devices. (CSCsk86697)

Table 8 Closed Caveats for Cisco Unified Personal Communicator

Identifier Severity Component Headline

CSCse77954 2 audio No Audio on CUPC Soft Phone Mode when you change the display 
settings.

CSCsf26033 2 ucpresence Presence not working w UDP over some VPN.

CSCsh41194 2 other CUPC is not failing back to primary CTI server automatically.

CSCsj63680 2 softphone SIP registration fails when presence user name is the same as the 
DN.

CSCsk92468 2 voicemail Closing CUPC while a voicemail is being played crashes the app. 

CSCsl04679 2 softphone One way audio.

CSCsl88235 2 user interface CUPC crash at startup if Citibank Virtual Account Number also 
installed

CSCsm71619 2 softphone Crash with Cisco WebEx, CUPC, and NeroVideo codec coinstalled

CSCsg17037 3 phonecontrol CUPC shows conversation window for calls originated from 
Non-Contr phone.

CSCsh16212 3 video Answer with video prevents later escalation prompting

CSCsh46900 3 esp Proxy attempts to send NOTIFY to CUPC on dead TCP 
connection.

CSCsh82782 3 softphone When the user minimizes conversation or main window, the audio 
interrupts.

CSCsj41525 3 softphone Calls that end due to temp fail are not noted as such

CSCsk72737 3 documentation File does not begin with '%PDF-'. error when launching PDF help.

CSCsm17852 3 other Crash when run on computer where "Embassy Security Suite" 
installed

CSCsm17852 3 other CUPC crashes with "Embassy Security Suite" installed

CSCso88574 3 user interface Crash when accessing any menu option after login
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  Caveats
• Ensure that all reachability-related messages between Cisco Unified Personal Communicator and 
Cisco Unified Presence use TCP. In Cisco Unified Presence Administration, choose 
System > Service Parameters. For the Cisco UP Presence Engine service, specify the Enterprise 
Presence Server Contact Name by using this format: ipaddress:port;transport=tcp. 

For the Cisco UP SIP Proxy service, set Use Transport in Record-Route Header to On.

• Embassy Security Suite software—is shipped with some newer Dell laptops as an optional 
application and causes Cisco Unified Personal Communicator to crash. Cisco Unified 
Personal Communicator memory becomes corrupted by an embassy Security Suite DLL 
(wxvault.dll) at run time. Uninstall the Embassy Security Suite application, and restart 
Cisco Unified Personal Communicator. (CSCsm17852)

• Tandberg video phones—users might not be able to add video to an audio call in Cisco Unified 
Personal Communicator if the recipient is using a Tandberg video phone.

Tandberg phones do not have the ability when receiving an audio call to escalate it to video. 
(CSCsi77912)

• Cyber Acoustics AC850 headset—users will experience low audio volume as compared to 
Plantronics or Sony USB headsets (CSCsi85963). 

Users should use a headset that is supported for use with Cisco Unified Personal Communicator as 
described in Table 4 on page 10 and Table 5 on page 12.

• (In Cisco Unified Personal Communicator Release 1.2(1) and earlier) Microsoft IntelliPoint Mouse 
software issue—Cisco Unified Personal Communicator freezes when users try to log in.

This problem can result from a known issue with Microsoft IntelliPoint Mouse software, 
Releases 6.0 and 6.1. You can uninstall the IntelliPoint software or try downgrading to Release 5.x 
of the IntelliPoint software and then restart your computer before relaunching Cisco Unified 
Personal Communicator. As a short-term solution, users can try setting Cisco Unified 
Personal Communicator to automatically log in. (CSCsi73977).

This problem is resolved with Cisco Unified Personal Communicator Release 1.2(2).

• (In Cisco Unified Personal Communicator Release 1.2(1) and earlier) Applications that change or 
enhance the behavior of the operating system cause Cisco Unified Personal Communicator to be 
unresponsive or behave strangely.

Applications, such as PowerToys for Windows XP, Hydravision by ATI, or TopDesk by Otaku 
Software should be uninstalled. (CSCsh96842)

This problem is resolved with Cisco Unified Personal Communicator Release 1.2(2).

Caveats
• Using the Bug Toolkit, page 24

• Open Caveats, page 24

• Resolved Caveats, page 28
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  Caveats
Using the Bug Toolkit 
You can search for problems by using the Cisco Software Bug Toolkit. Known problems (bugs) are 
graded according to severity level. These release notes contain descriptions of these types of bugs:

• All severity level 1 or 2 bugs

• Significant severity level 3 bugs

• All customer-found bugs

Before You Begin

To access Bug Toolkit, you need these items: 

• Internet connection 

• Web browser

• Cisco.com user ID and password 

Procedure 

Step 1 Go to http://tools.cisco.com/Support/BugToolKit/action.do?hdnAction=searchBugs to access the Bug 
Toolkit.

Step 2 Log in with your Cisco.com user ID and password. 

Step 3 Enter the bug ID number in the Search for Bug ID field, then click Go to find information about a 
specific problem. 

For information about how to search for bugs, create saved searches, create bug groups, and so forth, 
click Help on the Bug Toolkit page.

Open Caveats
Table 9 describes possible unexpected behavior by Cisco Unified Personal Communicator on Windows 
and Mac OS. Only severity 1, severity 2, and select severity 3 open caveats, as well as all customer-found 
defects, are provided in this document (highest severity listed first and then in alphanumeric order by 
identifier). 

Unless otherwise noted, these caveats apply to all Cisco Unified Personal Communicator releases. For 
details about an individual defect, click the identifier to access the online record for that defect in the 
Bug Toolkit.

Because defect status continually changes, be aware that the tables reflects a snapshot of the defects that 
were open at the time this report was compiled. For an updated view of open defects, access the Bug 
Toolkit. For details, see the “Using the Bug Toolkit” section on page 24.

Note Some caveats described in the Cisco Unified Presence release notes and in the Cisco Unified 
Communications Manager release notes might appear to be Cisco Unified Personal Communicator 
caveats. You can access these release notes at these URLs:

http:/www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html
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  Caveats
Table 9 Open Caveats for Cisco Unified Personal Communicator

Identifier Severity Component Headline

CSCsj10401 2 voicemail When playing forwarded messages, only introduction is played

CSCsm14484 2 ucpreference CUPC crashes when file>preferences is opened during login process

CSCsm76282 2 softphone No DTMF when muted on call to MP 7.0

CSCso00806 2 voicemail Unity:Unable to connect to VoiceMail server from previous CUPC 
versions

CSCse59392 3 other Presence works intermittently with McAfee Virus Scan.

CSCse59408 3 other Hub dialpad doesn’t use # character to terminate digit analysis.

CSCse66412 3 other Phone mode doesn't switch to Disabled after Extension Mobility logout.

CSCsf10533 3 other Mode switch is not possible when desk phone is down during outgoing 
call.

CSCsg03327 3 video No video when Tandberg was in a merge with 2 UCs.

CSCsg21311 3 video SIP video: issue with consult xfer call over SIPICT and H323ICT.

CSCsh38011 3 softphone CUPC displays online (no phone) after TFTP failover.

CSCsh70644 3 video Transfer to/from CUPC fails

CSCsh91397 3 softphone Calling ID is displayed even if the translation pattern is configured.

CSCsh98248 3 other Not able to unhold and merge from the video or audio conf window.

CSCsi12417 3 video cupc-mtp-cuva call crashes cupc with stop/strat vta & hold/res on cuva.

CSCsi30376 3 audio Voice Quality is lower with iLBC than G711.

CSCsi31441 3 audio Low Voice Quality from 7911 to CUPC.

CSCsi31601 3 audio Audio Conf would not bridge to MPE when CUPC contact method is 
Audio.

CSCsi33079 3 login Mac CUPC does not use local CNF file.

CSCsi35803 3 video Video call invitation after user disconnects from conference.

CSCsi52464 3 video No Remote Video from Tandberg on CUPC client and Polycom 
Endpoint.

CSCsi54522 3 softphone Getting MOH for all the other users in conf when RTP users hold the 
call.

CSCsi65782 3 ucchat CUPC: when CUP disables IM globally, existing IM session can send 
IMs.

CSCsi67858 3 other The Last Attempt and Last Update times on Server Health don't update.

CSCsi68414 3 voicemail Voice mails disappear from Recent comm after accessing them via IP Ph.

CSCsi72955 3 voicemail VM from Cisco personal Communication Assistant is not read by CUPC.

CSCsi84640 3 login CUPC ignores hosts file on local PC and requires DNS.

CSCsi88630 3 other After transfer of video call caller still sees the picture of transferee.

CSCsi89869 3 softphone CUPC does not receive calls for 2 mins when logged in multiple 
machines.

CSCsi94400 3 installer Vista - Unable to re-install camera driver if camera is connected.

CSCsi94461 3 other Roster displays blank if calling party’s caller ID is blocked.
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  Caveats
CSCsi94476 3 installer VT Camera works even after uninstalling camera driver.

CSCsi97864 3 database Away and Available custom messages are deleted after relaunch.

CSCsi99847 3 softphone CUPC call to MeetingPlace conference gets disconnected after two 
hours.

CSCsj12933 3 video Blank Video during Video Conference after hold and resume.

CSCsj13768 3 user interface Phone controls don’t work for a while after docking with desk phone 
call.

CSCsj14735 3 video Answer with Video doesn’t.

CSCsj33059 3 other Cannot switch to Deskphone from Softphone if TFTP not configured.

CSCsj36511 3 voicemail CUPC is crashing after sending invalid VoiceMessage to the user.

CSCsj41525 3 softphone Calls that end due to temp fail are not noted as such.

CSCsj42059 3 voicemail Vista - Unable to connect to Unity Connection using SSL/TLS port.

CSCsj45609 3 other CUPC cannot enter deskphone mode when primary CUCM is down.

CSCsj46489 3 user interface Ringing and ringback play on the wrong device after changing dflt 
device.

CSCsj48031 3 phone control Cannot switch from desk phone to softphone after sleep with soft VPN.

CSCsj64598 3 other CUPC does not timeout when logging in with bad password in auto login 
mode.

CSCsj83701 3 voicemail CUPC displays incorrect phone number for forwarded voicemail.

CSCsk09189 3 audio CUPC Poor Audio Quality in Softphone Mode.

CSCsk29353 3 video No remote video on cupc2 when call is escalated.

CSCsk33327 3 softphone Device Mobility is not working for CUPC/CIPC end points.

CSCsk34451 3 video No Remote or Local video displayed, after display settings are changed.

CSCsk42344 3 video Streaming video transferred to held call session window on video 
re-size.

CSCsk42861 3 other On the phone = Never - status is on the phone when user is in a meet.

CSCsk48403 3 softphone International calling behavior different with Softphone & Deskphone 
mode.

CSCsk65859 3 ucpresence Removing contact from buddy list removes presence in IM window.

CSCsk76123 3 softphone Vista Enterprise: CUPC crashes at startup when Logitech QuickCam 
used.

CSCsk86690 3 video Conf initiator need to hold/resume to join if call held by remote user.

CSCsk88040 3 softphone Unable to resume the Video after De Escalating/Escalating to 
conference.

CSCsk93175 3 video CUPC video shows local video when call is audio.

CSCsk97550 3 softphone Very loud static on MeetingPlace when CUPC puts MeetingPlace on 
hold.

CSCsl04169 3 other Warning msg indicating that outlook is open is not shown while 
upgrading.

Table 9 Open Caveats for Cisco Unified Personal Communicator (continued)

Identifier Severity Component Headline
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  Caveats
CSCsl06734 3 softphone Softphone Conference call remains a conf after 3rd party drops.

CSCsl11012 3 video Users in RTP cluster are unable to merge the users into Video 
conference.

CSCsl11256 3 video CUPC preserving the last presence status, when windows shutdown.

CSCsl12713 3 video CUPC does not pop up video window until escalated.

CSCsl13488 3 softphone CUPC allocates additional memory after returning from Standby.

CSCsl31146 3 video CUPC shows video when call is transferred to audio phone.

CSCsl32123 3 other Focus cant be moved using Shift+F6 key.

CSCsl37176 3 login Crash when dialpad open and same user logged in remotely.

CSCsl50789 3 softphone DSCP settings cant be set in Vista OS the way they are in XP.

CSCsl53816 3 ucchat User not able to send IM after recovery from n/w outage.

CSCsl57027 3 softphone Crash on answering incoming call just after network outage.

CSCsl62714 3 directory search Not able to add or delete any contact if the Ethernet cable is unplugged.

CSCsl63141 3 other Call statistics win doesn’t reopen once it is closed by pressing Enter.

CSCsl72193 3 video Session window cant be zoomed in by clicking on the + icon.

CSCsl72307 3 phone control Unable to place call after CCM failover in deskphone mode.

CSCsl74992 3 other Roster update issue: Invite for escalation to web not sent to all users.

CSCsl88235 3 user interface CUPC crashes immediately upon execution.

CSCsl88876 3 installer CUPC installer did not prompt warning message for Open Outlook 
windows.

CSCsm20660 3 video Local video shows black window after re-docking the laptop.

CSCsm32960 3 softphone CUPC behavior when receiving an Service Control Notify

CSCsm33461 3 softphone Calling name (CNAM) not displayed in softphone mode

CSCsm33470 3 phone control Calling name (CNAM) displayed inconsistently in phone control mode

CSCsm48529 3 other CUPC throws exceptions during login to SM server

CSCsm48748 3 login CUPC crashes after logging on to another machine under the same 
account

CSCso15174 3 directory search Application becomes unresponsive if LDAP server type is misconfigured

CSCso31826 3 voicemail Incoming voicemail reply shows self as sender

CSCso88574 3 user interface Crash when accessing any menu option after login

CSCsq17201 3 phone control Calling name (CNAM) displayed inconsistently in phone control mode

CSCsq71409 3 integrations CUPC Outlook plugin (admin install) not available for other user

CSCsl32096 5 user interface Enable conversation toolbar on IM window causes incorrect painting.

CSCsr13767 5 ucchat IM window improperly painted

CSCsj50319 6 user interface CUPC Desktop client footprint large.

CSCsj50339 6 user interface Date / Time format cannot be customized.

CSCsk18197 6 ucpresence Cups 1.03 to 6.01 Upgrade Guide.

Table 9 Open Caveats for Cisco Unified Personal Communicator (continued)

Identifier Severity Component Headline
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  Caveats
Resolved Caveats
Tables in this section list caveats that are resolved in Cisco Unified Personal Communicator but that 
might be open in previous releases: 

• Resolved in Release 1.2(4)

• Resolved in Release 1.2(3)

• Resolved in Release 1.2(2)

• Resolved in Release 1.2(1)

Only severity 1, severity 2, and select severity 3 resolved caveats, as well as all resolved customer-found 
defects, are provided in this document (highest severity listed first and then in alphanumeric order by 
identifier). For details about an individual defect, click the identifier to access the online record for that 
defect in the Bug Toolkit.

Because defect status continually changes, be aware that the table reflects a snapshot of the defects that 
were resolved at the time this report was compiled. For an updated view of resolved defects, access the 
Bug Toolkit. For details, see the “Using the Bug Toolkit” procedure on page 24.
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  Caveats
Table 10 Resolved in Release 1.2(4)

Identifier Severity Component Headline

CSCsr75216 2 phone control CUPC not able to get Desk Phone when UPC was not configured

CSCsr65890 3 softphone CUPC softphone doesn’t work if delay between CUPC and 
CUPS/CUCM is high

CSCsr77607 3 user interface CUPC 1.2(3) German version crash when navigating to Help > About

Table 11 Resolved in Release 1.2(3)

Identifier Severity Component Headline

CSCsm47670 2 integrations Outlook crashes on use with CUPC toolbar

CSCsm48212 2 integrations CUPC Outlook toolbar fails to load for certain contacts

CSCsm71552 2 ucchat First IM is often dropped

CSCsq43983 2 other Voicemail and MeetingPlace passwords appear in log when set/changed

CSCsq60603 2 other Unable to save password of Meeting place/Voicemail servers for new 
users

CSCsq90534 2 webcollaboration Web conference and help do not work when default browser is Firefox 
3.0

CSCsf14204 3 softphone Session roster is not always accurate or complete

CSCsg17732 3 directory search Mapping of LDAP attributes to multiple CUPC fields breaks Add 
Contact

CSCsj33077 3 user interface Voicemails always played on the Windows default sound playback 
device

CSCsj94838 3 softphone Dual Ringback heard on PSTN Calls with H323 Gateway

CSCsl44308 3 user interface Attempting to delete contact group twice leads to a crash

CSCsl63971 3 acupressure case-sensitivity on proxy domain causes CUPC problems

CSCsl73438 3 ucpresence Presence status stuck in Available status, when changed the networks.

CSCsl91214 3 softphone When unplugged the network cable, the Presence is not updated to 
others

CSCsm01320 3 user interface CUPC Client and Unity Connection Web Password must allow same 
length

CSCsm10658 3 user interface Deselecting the formatting toolbar distorts IM window painting

CSCsm11394 3 softphone Contact list disappeared in CUPC, when network change occurred

CSCsm29278 3 ucpresence CUPC uses 'Away' to reflect off-hook event

CSCsm59574 3 other Roster displays IP address of CUCM along with conf participants list

CSCsm59662 3 other CUPC conv window displays CUCM IP if remote user drops off from 
conf

CSCsm70916 3 softphone Dual Ringback heard on PSTN Calls with H323 Gateway

CSCsm92577 3 integrations CUPC Outlook toolbar prevents Windows OS shutdown or restart

CSCsm97308 3 integrations CUPC Outlook toolbar gets disabled when closing Outlook
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CSCsm97462 3 other Crash if certificate Issued by/to "Not Available" installed on host PC

CSCso10338 3 softphone Crash if video capture device reports null capabilities

CSCso27433 3 integrations Direct dial option is not working intermittently with Outlook 2003

CSCso31241 3 softphone No error displayed when merging calls fails

CSCso31341 3 wlc-rf NM: w56 supported power levels incorrect

CSCso38800 3 softphone CUPC polls too frequently for conference roster

CSCso41896 3 other Passwords stored in clear text in CUP database (ucendusercfg table)

CSCso67189 3 softphone Philips SpeechMic does not work with other apps while CUPC is 
running

CSCso73168 3 softphone Phone selection menu is not accessible if softphone fails

CSCso85803 3 directory search Configuring non-recursive search in LDAP profile has no effect

CSCsq61189 3 voicemail CUPC Cannot Connect to Voicemail Server

CSCsq71409 3 integrations CUPC Outlook plugin (admin install) not available for other user

CSCsj10952 4 other Incoming calls with unknown calling party display IP address of CUCM

CSCsl58132 4 user interface Matching Navigation skips names

CSCsm13502 4 user interface Contact list sorting order changed by Recent Comms sorting change

CSCsm51059 4 user interface Can't call outlook contacts with just a Company Name

CSCsm71940 4 other Modal and modeless dialogs placed on wrong screen

CSCsm73314 4 integrations Selecting number in 'Direct Dial' text box and clicking out places call

CSCsm20664 6 webcollaboration CUPC web conf login username field is max of 20 characters

CSCsm79461 6 user interface CIA-1489: Add 911 disclaimer to Help About

CSCsq89804 6 directory search Improve search response times by using "starts with" pattern matching

Table 12 Resolved in Release 1.2(2)

Identifier Severity Component Headline

CSCsi93788 2 directory search Adding more than 100 contacts at once causes app to be non-responsive.

CSCsi97895 2 login Crash if status menu is open during forced logout.

CSCsi97925 2 login Mac: crash if status menu is open during forced logout.

CSCsj27318 2 other Outlook toolbar doesn’t allow to dial if the contact has no email id.

CSCsj28714 2 user interface Crash when purging a recent comm while its detail window is open.

CSCsj44693 2 phone control Vista: can’t switch phone modes after suspend and resume sometimes.

CSCsj89092 2 ucchat Unable to receive IM from non-contact that is in Recents.

CSCsk41411 2 user interface CUPC Crash on resume from standby with a bad pointer.

CSCsk47046 2 ucchat CUPC - Long URL in IM crashes sending client.

CSCsk66169 2 softphone CUPC crashed while CUPC is idle.

CSCsl06541 2 other CUPC crash when closing the window while listening to voicemail.

Table 11 Resolved in Release 1.2(3) (continued)

Identifier Severity Component Headline
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi93788
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi97895
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi97925
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj27318
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj28714
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj44693
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj89092
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk41411
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk47046
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk66169
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl06541
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm97462
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso10338
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso27433
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso31241
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso31341
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso38800
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso41896
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso67189
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso73168
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCso85803
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq61189
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq71409
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj10952
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl58132
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm13502
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm51059
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm71940
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm73314
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm20664
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsm79461
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsq89804


 

  Caveats
CSCsl15374 2 softphone CUPC crashed after coming out of standby mode.

CSCsh59490 3 softphone Can’t send to VM when CUPC shares line with IP Phone.

CSCsi08767 3 voicemail *X username* appears in voicemail from / missed calls when unknown 
calls.

CSCsi27441 3 user interface Alt+Tab between CUPC and other windows disables CUPC main hub.

CSCsi64275 3 voicemail Forwarded voicemails show up in recent com with wrong name.

CSCsi94466 3 phone control Mac: Roster displays blank if calling party’s caller ID is blocked.

CSCsi96967 3 user interface Incoming call when computer is locked: Answer options dialog is black.

CSCsi97882 3 softphone Volume slider position does not change when the menu items are 
invoked.

CSCsj00783 3 other CUPC stop responding after a while and can't be maximized.

CSCsj10472 3 ucchat IM goes to a different CUPC user after n/w disconnect and reconnect.

CSCsj23783 3 ucpresence Application crashes without any error message after logging in.

CSCsj27820 3 user interface Presence drop down is dimmed after sleep.

CSCsj33747 3 other CUPC Crashed while on an active call with several users.

CSCsj34999 3 user interface Ctrl-Shift-V shortcuts in other apps do not work when CUPC is running.

CSCsj38709 3 ucpresence Presence shows as Offline after undock/redock.

CSCsj44885 3 other Alt. Phone Device Wnd incorrectly opens when switching to desk 
phone.

CSCsj47262 3 other In a Meeting preference dependent on On the Phone Preferences.

CSCsj47898 3 softphone Unable to see the local messages in chat session, CUPC crashed when 
close.

CSCsj48471 3 ucpresence Presence does not work when wireless (WLAN) is added later to winXP.

CSCsl37167 3 user interface Pressing tab key enables IMs Conversation tool bar icons.

CSCse85487 4 installer CUPC Installer needs to require XP SP2.

CSCsh39527 4 user interface Stop button doesn’t stop the on-going LDAP search.

CSCsj36503 4 other Timestamps in IM window do not reflect changes to system time zone.

CSCsk19903 6 login CUPC needs to allow @ in userid.

Table 13 Resolved in Release 1.2(1)

Identifier Severity Component Headline

CSCsf19489 2 directory search Crash on exit.

CSCsg15261 2 userinterface Crash in voicemail code while shutting down.

CSCsg31394 2 softphone CUPC doesn’t attempt to register with CCM on Busy Here 
response.

CSCsh22653 2 video No video to from CUPC to CUVA when CUVA launched midcall.

CSCsh93015 2 ucpresence Unicode characters in reachability status message cause a crash.

Table 12 Resolved in Release 1.2(2) (continued)

Identifier Severity Component Headline
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl15374
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh59490
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi08767
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi27441
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi64275
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi94466
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi96967
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi97882
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj00783
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj10472
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj23783
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj27820
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj33747
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj34999
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj38709
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj44885
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj47262
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj47898
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj48471
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsl37167
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCse85487
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh39527
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj36503
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsk19903
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsf19489
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsg15261
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsg31394
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh22653
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh93015


 

  Caveats
CSCsi22240 2 video CUPC sends incorrect PT for video in certain hold/resume 
scenarios.

CSCsi31998 2 softphone Pound(#) key not worked as access code at CUPC.

CSCsi40186 2 phonecontrol Cannot make phone call when switching to control other device.

CSCsi42830 2 video Mac system froze during negative testing.

CSCsi45808 2 other Address book plug-in doesn’t work.

CSCsi52163 2 directory search Directory search fails when any attribute used is not defined in 
CUP.

CSCsi54082 2 other resiplog.txt file fills up hard drive.

CSCsi59870 2 other Crash while searching-incorrect credentials on CUPS page.

CSCsi64846 2 other When deleting a contact, the resulting error dialog causes an 
Assert.

CSCsi67419 2 softphone CUPC does not register in softphone mode if username is > 12 
characters.

CSCsi90292 2 softphone Receiving audio on XP delayed after resuming from sleep.

CSCsi95159 2 login Failure to start correctly if LDAP bind fails due to invalid 
credentials.

CSCsj39390 2 ucpreference Local user’s presence status is not correct after waking from sleep.

CSCse77831 3 userinterface Preferred contact method for user in conf roster is CHAT should be 
VIDEO.

CSCsf04558 3 other CUPC status shows Connected with Ethernet cable unplugged.

CSCsf12322 3 voicemail Unable to download 500 voicemail. The user becomes unusable.

CSCsf12964 3 userinterface Context menu item Add Contact is disabled right after search 
completes.

CSCsg04247 3 video Remote video is black on Tandberg if Tandberg calls CUPC.

CSCsg07934 3 userinterface Unable to cancel call when callee exits before connect the call.

CSCsg17427 3 other Unable to Unhold when call is made with Polycomm and CUPC.

CSCsg68228 3 video Poor video quality or no video over lossy network connections.

CSCsh26653 3 other System Diagnostics for LDAP Server always show 'Anonymous 
Bind' as yes.

CSCsh54452 3 video CUPC to CUPC video calls over H323 fails to establish.

CSCsh58735 3 userinterface After bad password attempt, server status window shows incorrect 
status.

CSCsh58748 3 other System diagnostics shows incorrect protocol for various server 
types.

CSCsh60853 3 directory search LDAP system diag always shows anonymous bind.

CSCsh75092 3 video Video rendered too early on video escalation over H.323 ICT.

CSCsh80488 3 userinterface System Diagnostics window shows incorrect status for TFTP & 
LDAP.

Table 13 Resolved in Release 1.2(1) (continued)

Identifier Severity Component Headline
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi22240
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi31998
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi40186
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi42830
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi45808
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi52163
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi54082
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi59870
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi64846
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi67419
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi90292
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi95159
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj39390
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCse77831
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsf04558
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsf12322
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsf12964
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsg04247
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsg07934
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsg17427
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsg68228
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh26653
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh54452
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh58735
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh58748
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh60853
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh75092
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh80488


 

  Troubleshooting
Troubleshooting
These Cisco Unified Personal Communicator documents provide troubleshooting information:

• User Guide for Cisco Unified Personal Communicator (separate documentation for Windows OS 
and for Mac OS)

• Troubleshooting Guide for Cisco Unified Personal Communicator

You can access these documents at this URL:

http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html

For Cisco Unified Presence troubleshooting information, see the troubleshooting guide and the 
serviceability administration guide at this URL:

http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

CSCsh91884 3 documentation XSS vulnerability via search facility in online help.

CSCsi00093 3 other No text / url in web collab. e-mail invitation message.

CSCsi65261 3 ucpresence Disabling CUPS capabilities doesn't change presence to Offline.

CSCsj26097 3 ucpreference Presence is in Available status when the users laptop is put into 
standby.

CSCsj33659 3 audio Vista: audio lost after escalating to video.

Table 13 Resolved in Release 1.2(1) (continued)

Identifier Severity Component Headline
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http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsh91884
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi00093
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsi65261
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj26097
http://tools.cisco.com/Support/BugToolKit/search/getBugDetails.do?method=fetchBugDetails&bugId=CSCsj33659
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html


 

  Documentation Updates
Documentation Updates
This section provides Cisco Unified Personal Communicator documentation updates that were 
unavailable when the product was released for documents available at:

http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html

• Updates for the Installation Guide for Cisco Unified Personal Communicator for Release 1.2(2), 
page 34

• Updates for the Troubleshooting Guide for Cisco Unified Personal Communicator for Release 
1.2(2), page 37

• Updates to the User Guide and Online Help for Windows, page 37 

• Updates to the Accessibility Document for Release 1.2(2) for Windows, page 41 

• Updates to the User Guide and Online Help for Mac OS, page 44 

• Updates to the Accessibility Document for Macintosh, page 47 

Updates for the Installation Guide for Cisco Unified Personal Communicator for 
Release 1.2(2)

• Enabling Cisco Unified Personal Communicator to Retrieve the jpegPhoto Attribute, page 34

• Mac Installer Package Names, page 35

• Deploying the Cisco VT Camera Drivers by Using the MSI Package, page 35

• Fetching Contact Pictures from a Web Server, page 36

• Adding Cisco Unified IP Phones to the Cisco Unified Communications Manager Database, page 37

Enabling Cisco Unified Personal Communicator to Retrieve the jpegPhoto Attribute

The jpegPhoto attribute is not available in Microsoft Active Directory Global Catalog server, and it is 
not indexed (http://msdn2.microsoft.com/en-us/library/ms676813.aspx). If your LDAP configuration 
uses Global Catalog port 3268, the jpegPhoto is not retrievable. 

Procedure

Step 1 Change the configuration in Cisco Unified Presence Administration (Application > Cisco Unified 
Personal Communicator > LDAP Server) to TCP and port 389. 

The photo is retrieved when you log in to Cisco Unified Personal Communicator again.

Step 2 Ensure that a picture is displayed when placing a call to a contact and that the picture is also displayed 
in the contact details. Make sure you create proper Directory Lookup Dial Rules in Cisco Unified 
Communications Manager if an application dial rule is configured.
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  Documentation Updates
When adding a contact in Cisco Unified Personal Communicator, the directory lookup returns a 10-digit 
number (for example, 1234567890). If the user places the call by dialing only four digits (for example, 
7890), the picture is not displayed because of 7890 does not match for 1234567890. You should:

• Create an outbound rule to remove the area code. The picture is shown in contact details.

• Create an inbound rule for directory lookup to prefix the area code (translate the 4-digit extension 
number into the 10-digit DID number stored in AD). The picture is shown when placing a call.

Mac Installer Package Names

These are the installer package names for Mac OS:

• CiscoUnifiedPersonalCommunicator-K9_ENU.dmg (US English only)

• CiscoUnifiedPersonalCommunicator-K9_ALL.dmg (US English and localized languages)

For both the US English-only version and the internationalized version for the Mac, Cisco Unified 
Personal Communicator uses the operating system settings and rules to determine the correct language 
to present to the user at runtime. You must download and install the international version of 
Cisco Unified Personal Communicator to have both US English and localized languages. If you 
download and install the US-only version, only US English is available.

Deploying the Cisco VT Camera Drivers by Using the MSI Package

For languages other than English, if you deploy the Cisco VT Camera driver through the MSI package, 
you must install a language locale by associating the locale .mst file to the TRANSFORMS parameter. 
For example, to install the French locale: 

msiexec /i CiscoVTCameraDriverSetup.msi /qb+ TRANSFORMS="1036.mst"

Table 14 lists the supported .mst filenames.

Table 14 Cisco VT Camera Driver .mst Filenames

Filename Language

1028.mst Chinese (traditional)

1030.mst Danish

1031.mst German

1034.mst Spanish

1036.mst French

1040.mst Italian

1041.mst Japanese

1042.mst Korean

1043.mst Dutch

1046.mst Portuguese

1049.mst Russian

1053.mst Swedish

2052.mst Chinese (simplified)
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  Documentation Updates
Fetching Contact Pictures from a Web Server

You can configure a parameterized URL in the Photo field in the LDAP attribute map in Cisco Unified 
Presence Administration so that Cisco Unified Personal Communicator can fetch pictures from a web 
server instead of from the LDAP server.

Before You Begin

• Use %%uid%% as the substitution string. 

You can use any LDAP attribute whose query value contains a piece of data that uniquely identifies 
the photo of the user. For example:

– http://wwwin.cisco.com/photo/std/%%uid%%.jpg

– http://wwwin.cisco.com/photo/std/%%sAMAccountName%%.jpg (for ActiveDirectory)

• The double percent symbols are required, and they must enclose the name of the LDAP attribute to 
substitute. 

Restrictions

• The URL length is limited to 50 characters in Cisco Unified Presence Administration. 

• This substitution technique works only if Cisco Unified Personal Communicator can use the results 
of the query and can insert it into the template specified above to construct a working URL that 
fetches a JPG photo. If the web server where photos are hosted in a company requires a POST (for 
example, the name of the user is not in the URL) or uses some other cookie name for the photo (for 
example, http://www..../1234.jpg) instead of the username, this technique will not work. 
Cisco Unified Personal Communicator does not support authentication for this query; the photo 
must be retrievable from the web server without credentials.

Procedure

Step 1 In Cisco Unified Presence Administration, choose Application > Unified Personal Communicator > 
Settings to display the Cisco Unified Personal Communicator Settings window.

Step 2 In the LDAP attribute map, configure a parameterized URL in the Photo field. Use %%uid%% as the 
substitution string.

Step 3 Click Save.

Cisco Unified Personal Communicator removes the percent symbols and replaces the parameter inside 
with the results of an LDAP query for the user whose photo is to be resolved. 

For example, if a query result contains the attribute “uid” with a value of “johndoe,” then a template such 
as http://mycompany.com/photos/%%uid%%.jpg yields the URL 
http://mycompany.com/photos/johndoe.jpg. Cisco Unified Personal Communicator attempts to fetch the 
photo. 

Note Because of this new feature to retrieve photos from a web server, the installation guide contains 
information in the section “Photo Setting Attribute and Format for Windows Active Directory” that is 
no longer true and should be ignored.
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  Documentation Updates
Adding Cisco Unified IP Phones to the Cisco Unified Communications Manager Database

When you add a Cisco Unified IP Phone to the Cisco Unified Communications Manager database, you 
assign a directory number in the Directory Number Configuration window. However, in the Line Settings 
for All Devices section, the Hold Reversion Ring Duration and the Hold Reversion Notification Interval 
settings are assignable, but they are not functional for Cisco Unified Personal Communicator.

Updates for the Troubleshooting Guide for Cisco Unified 
Personal Communicator for Release 1.2(2)

Problem The user can send instant messages to others, but they cannot send instant messages back to this 
user.

Solution In Cisco Unified Personal Communicator, instant messages and presence information do not 
work correctly if the local proxy domain is configured in uppercase letters (user@DOMAIN.COM). 
Cisco Unified Personal Communicator interprets that the incoming instant message or presence 
notification is for a different contact because the domain in the IM is in lowercase (user@domain.com). 
The mismatch causes Cisco Unified Personal Communicator to regard the instant message as coming 
from a different entity for which it sees no presence and presumes to be IM incapable.

The workaround is to change the proxy domain setting in Cisco Unified Presence to lowercase. In 
Cisco Unified Presence Administration, select System > Service Parameters. Select the server and the 
SIP Proxy service. Verify that the entry for Proxy Domain is in lowercase letters. If it is in uppercase, 
make it lowercase, and click OK.

Updates to the User Guide and Online Help for Windows
The following changes apply to the online help in release 1.2(2) and to the user guide at 
http://www.cisco.com/en/US/products/ps6844/products_user_guide_list.html, which applies to both 
Releases 1.2(2) and 1.2(1). 

Applies To 
Release  Chapter in PDF 

Topic or Section 
in Online Help New or Changed Information 

1.2(2) Preparing to Use Cisco Unified 
Personal Communicator 

(New feature) To automatically start Cisco Unified 
Personal Communicator when you start your computer: 

1. Choose File > Preferences. 

2. Click Profile. 

3. Check Start this application when I start up my 
computer. 

By default, this option is not checked. 

1.2(2) Having Conversations Using 
Cisco Unified 
Personal Communicator

Responding to 
Incoming Calls 

When you click Send to Voicemail, your desk phone no 
longer continues to ring. 
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1.2(2) 

1.2(1) 

Using Video with 
Cisco Unified 
Personal Communicator 

Viewing Video To use video in a standard Cisco Unified MeetingPlace or 
Cisco Unified MeetingPlace Express meeting (as distinct 
from web conferencing that you add via the conversation 
window in Cisco Unified Personal Communicator), see the 
Online Help for your conferencing product. 

The general procedure is this: 

1. Dial out from the meeting. 

2. Specify that you are dialing out to a video endpoint. 

3. When Cisco Unified Personal Communicator rings, 
click Answer with Video. 

1.2(2) Using Video with 
Cisco Unified 
Personal Communicator 

Working with 
Video 
Conversations 
In Progress

To resize the incoming video image: Drag an edge or corner 
of the conversation window. 

To resize the image of yourself: Choose View > Local 
Video Size from the menu in the conversation window. 

If you resize an image using a menu, the size you see 
depends on the resolution of your display. 

To move the image of yourself: Drag it to another corner. 

To hide or show the image of yourself: Right click in the 
image window and choose Show Local Video. 

1.2(2) 

1.2(1) 

Hosting Conference Calls with 
Cisco Unified 
Personal Communicator 

About Merging 
Calls

The maximum number of conference call participants 
depends on the system at your organization. 

1.2(2) Managing Contacts About the 
Contact List 

Your contact list is now automatically alphabetized by first 
name within each group. 

Tip To float a name to the top of a group, right-click the 
name and edit the contact a nickname so that it 
begins with an underscore. Example: _Joe Smith. 

1.2(2) Managing Contacts Adding 
Contacts to Your 
List 

To add a contact, drag a named contact to your contact list 
from one of the following lists: the Recent 
Communications list, the search results list, or a 
conversation roster. 

To move a contact from one group to another within your 
contact list, drag it. 

To copy a contact from one group to another within your 
contact list, control-drag it. 

Note Drag the name onto a group name or another name 
in the group, not into the empty space at the bottom 
of the list. 

1.2(2) Managing Contacts Searching for 
Contacts 

The start search button has changed to a magnifying-glass 
icon. 

The button to stop a search has been removed. 

To stop a search in progress, press Esc. 

Applies To 
Release  Chapter in PDF 

Topic or Section 
in Online Help New or Changed Information 
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1.2(2) • Managing Contacts

• Working with Recent 
Communications 

• Working 
with Search 
Results 

• Working 
with the 
Recent 
Communica
tions List 
and Its 
Items 

To instantly resize a column to display the complete text of 
the longest item in the column: 

1. Right click an item in the column to resize. 

2. Choose Best Fit. 

If more information is added, you may need to perform this 
action again. 

1.2(2) • Managing Contacts

• Working with Recent 
Communications 

• Working 
with Search 
Results 

• Working 
with the 
Recent 
Communica
tions List 
and Its 
Items 

To jump to a name on a list: 

1. Click any name in the list. 

2. Type the first letter of the name to jump to, or quickly 
type the first few letters. 

1.2(2) Troubleshooting Application Is 
Unresponsive 
Or Behaves 
Strangely

This section does not apply to Release 1.2(2). 

1.2(2) 

1.2(1) 

Troubleshooting Problems 
Starting Calls Problem When I click numbers in the dial pad, sometimes 

they are not dialed. 

Solution When you click the same digit more than once, 
pause briefly between clicks. 

1.2(2) 

1.2(1) 

Troubleshooting Problems 
During Calls Problem When I click numbers in the keypad in the 

conversation window, sometimes they are not dialed. 

Solution When you click the same digit more than once, 
pause briefly between clicks. 

Applies To 
Release  Chapter in PDF 

Topic or Section 
in Online Help New or Changed Information 
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1.2(2) 

1.2(1) 

Troubleshooting Problems with 
Your Camera or 
Video 

Problem My video preview does not work and I cannot 
initiate or receive calls. The application appears to hang. 

Problem Plug your camera directly into the USB port on 
your computer, or try a USB 2.0 hub. Your camera may not 
be compatible with USB version 1.1 hubs or hubs without 
power adaptors. 

1.2(2) 

1.2(1) 

Troubleshooting Problems 
Accessing 
Online Help

Problem In the online help, when I click View PDF, the 
PDF does not open. 

Solution

• Make sure the latest Adobe Reader is installed.

• If you are using Internet Explorer: Enable Display 
PDF in browser in Adobe Reader Preferences. 

Applies To 
Release  Chapter in PDF 

Topic or Section 
in Online Help New or Changed Information 
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Updates to the Accessibility Document for Release 1.2(2) for Windows 
The following changes for Release 1.2(2) apply to Accessibility Features In Cisco Unified 
Personal Communicator for Windows, Release 1.2: Keyboard Navigation: 

• Moving the Input Focus, page 41 

• Expanding and Collapsing Panes, page 41

• Resizing the Panes in the Main Console, page 42

• Resizing Columns, page 42

• Sorting List Items, page 43

• Working with Video: Moving the Image of Yourself, page 43 

• Getting More Information About Accessibility and This Product, page 43 

Note The following caveat has been removed for this release: If a keyboard shortcut does not seem to work, 
move your mouse away from any buttons and try again. 

Moving the Input Focus 

Expanding and Collapsing Panes 

Procedure 

To expand or collapse a pane, for example in the main console or in a Contact Details window: 

Step 1 Move the focus to the pane to expand or collapse. 

Step 2 Press the space bar. 

Operation Keyboard Shortcut 

Move the input focus within the panes of the console, between the buddy list, 
recent list, and search list. 

The pane must be open. 

F6

Move the input focus between windows in Cisco Unified 
Personal Communicator. 

Ctrl+F6

Move the input focus between windows in the opposite direction. Ctrl+Shift+F6
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Resizing the Panes in the Main Console 

Note • The console must be larger than its minimum size.

• If you make a pane larger, the pane below it becomes proportionately smaller. 

• A pane that will become smaller cannot already be at its minimum size. 

Procedure 

Step 1 Expand the pane you want to resize, if it is not already open. 

Step 2 Select the pane divider to move: 

Step 3 Move the pane divider up or down: 

Resizing Columns 

You can resize a column in the Recent Communications or search results panes to display the complete 
text of the longest item in the column. 

Procedure 

Step 1 Tab to the list that has the column you want to resize. 

Step 2 Use the arrow keys to select any item in the list. 

You must press an arrow key at least once. 

Step 3 Press Shift+F10. 

Select The Divider Keyboard Shortcut 

Between the Contacts pane and the Recent Communications pane. Ctrl+Shift+1 

Between the Recent Communications pane and the Search Results pane. Ctrl+Shift+2 

Below the Search pane. Ctrl+Shift+3

Move the Selected Divider Keyboard Shortcut 

Up or down by about a pixel Up arrow

Down arrow 

Up or down by about 3 pixels PgUp 

PgDn

Up as far as possible Home 

Down as far as possible End 
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Step 4 Choose Best Fit. 

Sorting List Items 

Sort search results and items in the Recent Communications list using the methods in the table: 

Procedure 

Step 1 Use the arrow keys to select any item in the list.

You must press an arrow key at least once. 

Step 2 Press Shift+F10. 

Step 3 Choose Arrange By. 

Step 4 Do one of the following: 

Working with Video: Moving the Image of Yourself 

When you view video, the image of yourself appears by default in a corner of the larger incoming image. 
You can move it to a different corner of the larger image. 

Getting More Information About Accessibility and This Product 

For more information about accessibility and this product (for example, to request a United States 
government Section 508 VPAT (Voluntary Product Accessibility Template), contact 
Accessibility@Cisco.com. 

To Do This 

Sort by different criteria Choose an option. 

Reverse the sort order (ascending or descending) Choose the same option that is already selected. 

To Move the Image Do This 

Up Ctrl+Shift+Up Arrow 

Down Ctrl+Shift+Down Arrow

Right Ctrl+Shift+Right Arrow 

Left Ctrl+Shift+Left Arrow 
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Updates to the User Guide and Online Help for Mac OS
The following changes apply to the online help in Release 1.2(2) and to the user guide at 
http://www.cisco.com/en/US/products/ps6844/products_user_guide_list.html, which applies to both 
Releases 1.2(2) and 1.2(1). 

Applies To 
Release  Chapter in PDF 

Topic or 
Section in 
Online Help New or Changed Information 

1.2(2) Preparing to Use 
Cisco Unified 
Personal Communicator

(New section) AppleScript is now supported. 

For information: 

1. Launch Script Editor.app. 

2. Choose File > Open Dictionary.

3. Choose the Cisco Unified Personal Communicator 
application. 

1.2(2) Having Conversations Using 
Cisco Unified 
Personal Communicator

Responding to 
Incoming 
Calls 

When you click Send to Voicemail, your desk phone no 
longer continues to ring. 

1.2(2) 

1.2(1) 

Using Video with 
Cisco Unified 
Personal Communicator 

Viewing Video To use video in a standard Cisco Unified MeetingPlace or 
Cisco Unified MeetingPlace Express meeting (as distinct 
from web conferencing that you add via the conversation 
window in Cisco Unified Personal Communicator), see the 
Online Help for your conferencing product. 

The general procedure is this: 

1. Dial out from the meeting. 

2. Specify that you are dialing out to a video endpoint. 

3. When Cisco Unified Personal Communicator rings, 
click Answer with Video. 

1.2(2) Using Video with 
Cisco Unified 
Personal Communicator 

Working with 
Video 
Conversations 
In Progress

To resize the video window of the incoming image: Drag the 
bottom right corner of the conversation window. 

You cannot make the window smaller than its minimum size.

You can drag the small image of yourself to the center of the 
large incoming video image. 

1.2(2) 

1.2(1) 

Hosting Conference Calls 
Using Cisco Unified 
Personal Communicator

About 
Merging Calls

The maximum number of conference call participants 
depends on the system at your organization. 

1.2(2) Sending Messages with 
Cisco Unified 
Personal Communicator 

Sending 
Instant 
Messages

To close a tab in an instant messaging window: 

Click the reachability status indicator in the tab. 
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1.2(2) Managing Contacts Adding 
Contacts to 
Your List 

To add a contact, drag a named contact or selected contacts 
to your contact list from one of the following lists: the 
Recent Communications list, the search results list, or a 
conversation roster. 

To move contacts from one group to another within your 
contact list, drag them. 

To copy a contact from one group to another within your 
contact list, Option-drag it. 

1.2(2) Managing Contacts About the 
Contact List 

Your contact list is now automatically alphabetized by first 
name within each group. 

In Release 1.2(1), the names were sorted by last name. 

Tip To float a name to the top of a group, right-click the 
name and edit the contact a nickname so that it 
begins with an underscore. Example: _Joe Smith. 

All Managing Contacts (New section) To reverse the sort order of the names in all groups in your 
contact list: 

Click the Name bar at the top of the list. 

1.2(2) Managing Contacts (New section) You can copy contact information from Cisco Unified 
Personal Communicator to other applications. 

Drag a named item from the console to one of the following 
locations: 

• Your Address Book 

• A text area of another application 

• A folder or your desktop (this action creates a VCard) 

1.2(2) • Managing Contacts • Working 
with 
Search 
Results 

To jump to a name on the list, do one of the following: 

• Type the first letter of the name to jump to. 

• Quickly type the first few letters of the name. 

Applies To 
Release  Chapter in PDF 

Topic or 
Section in 
Online Help New or Changed Information 
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1.2(2) Troubleshooting • I Hear No 
Sound or 
the 
Volume is 
Too Low 

To adjust the volume you hear, you no longer need to adjust 
the Sound settings in System Preferences. 

To adjust volume settings: 

1. Choose CiscoUPC > Preferences. 

2. Click Audio/Video. 

To change the volume of alerts and the ringer: 

1. Choose a device for Ringer & Alerts. 

2. Adjust the Device Volume. 

3. If you need to modify the volume further, adjust the 
Ringer & Alerts Volume. 

4. Verify that you can still hear conversations during a call. 

To change the volume of conversation and other sounds you 
hear during a call, such as dial tones or busy signal: 

1. Choose a device for Audio Call Output.

2. Adjust the Device Volume. 

3. If you need to modify the volume further, adjust the 
Default Call Volume. 

4. Verify that you can still hear the ringer and alerts. 

Note

• The two Device Volume sliders in the Cisco Unified 
Personal Communicator preferences and the Output 
Volume slider in the Sound settings in the System 
Preferences all control a single volume setting. A change 
you make to any of these sliders affects all of them, and 
may affect other applications that play sounds. 

• The Default Call Volume and the Ringer & Alerts 
Volume are a percentage of the Device Volume that you 
set. 

• The Default Call Volume and the Ringer & Alerts 
Volume settings do not affect the Sound settings in 
System Preferences. 

Applies To 
Release  Chapter in PDF 

Topic or 
Section in 
Online Help New or Changed Information 
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Updates to the Accessibility Document for Macintosh 
The following change for Release 1.2(2) applies to Accessibility Features In Cisco Unified 
Personal Communicator for Macintosh, Release 1.2: Keyboard Navigation: 

Getting More Information About Accessibility and This Product 

For more information about accessibility and this product (for example, to request a United States 
government Section 508 VPAT (Voluntary Product Accessibility Template), contact 
Accessibility@Cisco.com. 

Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

This product contains cryptographic features and is subject to United States and local country laws 
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply 
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors 
and users are responsible for compliance with U.S. and local country laws. By using this product you 
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local 
laws, return this product immediately. 

A summary of U.S. laws governing Cisco cryptographic products may be found at: 
http://www.cisco.com/wwl/export/crypto/tool/stqrg.html. If you require further assistance please 
contact us by sending e-mail to export@cisco.com. 

1.2(2) 

1.2(1) 

Troubleshooting Problems with 
Your Camera 
or Video 

Problem My video preview does not work and I cannot 
initiate or receive calls. The application appears to hang. 

Solution Plug your camera directly into the USB port on your 
computer, or try a USB 2.0 hub. Your camera may not be 
compatible with USB version 1.1 hubs or hubs without 
power adaptors. 

Problem The video image is fuzzy. 

Solution Use a wired connection instead of a wireless 
connection. 

Applies To 
Release  Chapter in PDF 

Topic or 
Section in 
Online Help New or Changed Information 
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